© 2010 Cheltenham Courseware Pty. Ltd.

All trademarks acknowledged. E&OE.

No part of this document may be copied without written permission from Cheltenham Courseware unless produced under the terms of a courseware site license agreement with Cheltenham Courseware.

All reasonable precautions have been taken in the preparation of this document, including both technical and non-technical proofing. Cheltenham Courseware and all staff assume no responsibility for any errors or omissions. No warranties are made, expressed or implied with regard to these notes. Cheltenham Courseware shall not be responsible for any direct, incidental or consequential damages arising from the use of any material contained in this document. If you find any errors in these training modules, please inform Cheltenham Courseware. Whilst every effort is made to eradicate typing or technical mistakes, we apologise for any errors you may detect. All courses are updated on a regular basis, so your feedback is both valued by us and will help us to maintain the highest possible standards.

Sample versions of courseware from Cheltenham Courseware
(Normally supplied in Adobe Acrobat format): If the version of courseware that you are viewing is marked as NOT FOR TRAINING, SAMPLE, or similar, then it cannot be used as part of a training course, and is made available purely for content and style review. This is to give you the opportunity to preview our courseware, prior to making a purchasing decision. Sample versions may not be re-sold to a third party.

For current license information
This document may only be used under the terms of the license agreement from Cheltenham Courseware. Cheltenham Courseware reserves the right to alter the licensing conditions at any time, without prior notice. Please see the site license agreement available at: www.cheltenhamcourseware.com.au/agreement

Contact Information

Australia / Asia Pacific / Europe (ex. UK / Ireland) / Rest of the World
Email: info@cheltenhamcourseware.com.au
Web: www.cheltenhamcourseware.com.au

USA / Canada
Email: info@cheltenhamcourseware.com
Web: www.cheltenhamcourseware.com

UK / Ireland
Email: info@cctglobal.com
Web: www.cctglobal.com

Cheltenham Courseware

SAMPLE

FOR USE AT THE LICENSED SITE(S) ONLY
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TUTOR SETUP INFORMATION</td>
<td>6</td>
</tr>
<tr>
<td>OUTLOOK 2010 SETUP &amp; CONFIGURATION</td>
<td>7</td>
</tr>
<tr>
<td>Initial configuration</td>
<td>7</td>
</tr>
<tr>
<td>A FIRST LOOK AT OUTLOOK 2010</td>
<td>8</td>
</tr>
<tr>
<td>Starting Outlook 2010</td>
<td>8</td>
</tr>
<tr>
<td>The Microsoft Outlook 2010 Screen</td>
<td>9</td>
</tr>
<tr>
<td>Help in Outlook 2010</td>
<td>12</td>
</tr>
<tr>
<td>Searching for Help</td>
<td>18</td>
</tr>
<tr>
<td>Printing help sheets</td>
<td>20</td>
</tr>
<tr>
<td>Microsoft Outlook Navigation Pane</td>
<td>20</td>
</tr>
<tr>
<td>Microsoft Outlook Ribbon</td>
<td>21</td>
</tr>
<tr>
<td>Closing Outlook</td>
<td>21</td>
</tr>
<tr>
<td>TERMINOLOGY &amp; CONCEPTS</td>
<td>22</td>
</tr>
<tr>
<td>What is email?</td>
<td>22</td>
</tr>
<tr>
<td>The structure of an email address</td>
<td>22</td>
</tr>
<tr>
<td>The advantages of using email</td>
<td>22</td>
</tr>
<tr>
<td>Recommendations for email content and use</td>
<td>23</td>
</tr>
<tr>
<td>SMS (Short Message Service)</td>
<td>23</td>
</tr>
<tr>
<td>Voice over Internet Protocol (VoIP)</td>
<td>24</td>
</tr>
<tr>
<td>Instant messaging</td>
<td>24</td>
</tr>
<tr>
<td>Online (virtual) communities</td>
<td>25</td>
</tr>
<tr>
<td>Social networking websites</td>
<td>25</td>
</tr>
<tr>
<td>Internet forums (message boards / discussion boards)</td>
<td>26</td>
</tr>
<tr>
<td>Chat rooms</td>
<td>26</td>
</tr>
<tr>
<td>Online computer games</td>
<td>27</td>
</tr>
<tr>
<td>SECURITY ISSUES</td>
<td>28</td>
</tr>
<tr>
<td>Spam</td>
<td>28</td>
</tr>
<tr>
<td>Viruses</td>
<td>28</td>
</tr>
<tr>
<td>Phishing</td>
<td>28</td>
</tr>
<tr>
<td>Digital signatures</td>
<td>29</td>
</tr>
<tr>
<td>SENDING MESSAGES</td>
<td>30</td>
</tr>
<tr>
<td>Creating and sending your first email</td>
<td>30</td>
</tr>
<tr>
<td>Checking that your email was sent</td>
<td>31</td>
</tr>
<tr>
<td>Sending emails to more than one person at a time</td>
<td>32</td>
</tr>
<tr>
<td>Receiving emails</td>
<td>33</td>
</tr>
<tr>
<td>Sending a copy of a message to another address</td>
<td>34</td>
</tr>
<tr>
<td>What is a blind carbon copy?</td>
<td>34</td>
</tr>
<tr>
<td>Sending a copy of a message to another address using blind carbon copy</td>
<td>34</td>
</tr>
<tr>
<td>Setting the message subject</td>
<td>35</td>
</tr>
<tr>
<td>Spell checking your message</td>
<td>35</td>
</tr>
<tr>
<td>Attaching a file to a message</td>
<td>36</td>
</tr>
<tr>
<td>Deleting an attached file from an outgoing message</td>
<td>37</td>
</tr>
<tr>
<td>Issues when sending file attachments</td>
<td>38</td>
</tr>
<tr>
<td>Setting message importance (message priority)</td>
<td>38</td>
</tr>
<tr>
<td>Setting message sensitivity</td>
<td>39</td>
</tr>
</tbody>
</table>
Saving a draft copy of an e-mail ................................................................. 39

RECEIVING, READING AND REPLYING TO MESSAGES ........................................... 41
The Inbox folder .................................................................................................. 41
Opening the Inbox folder ................................................................................... 41
The Inbox screen .................................................................................................. 42
Selecting a message ........................................................................................... 42
Message Status icons ......................................................................................... 43
Reading a message ............................................................................................. 43
Switching between open Message windows ..................................................... 44
Forwarding a message ........................................................................................ 45
Opening or saving an attached file .................................................................... 46
Replying to the sender of a message .................................................................. 47
Replying to the sender and all recipients of a message ....................................... 48
Setting message reply options so that the original message is inserted, or not
inserted ................................................................................................................ 50
Printing a message ............................................................................................. 52
Previewing a message before printing ............................................................ 53
Printing Options ................................................................................................ 54

MANIPULATING TEXT AND FILES .............................................................................. 56
Selecting a word within the Message window .................................................... 56
Selecting a line within the Message window ..................................................... 56
Selecting a paragraph within the Message window .......................................... 57
Selecting all text within the Message window .................................................. 57
Selecting text using the mouse ......................................................................... 57
Copying text to the Clipboard from a message ................................................... 58
Pasting text from the Clipboard into a message ............................................... 58
Copying text from one message to another ....................................................... 58
Cutting text to the Clipboard from a message ................................................... 59
Moving text from one message to another ........................................................... 59
Copying text from another application into a message .................................... 59
Deleting text in a message .................................................................................. 60
Deleting text to the left of the insertion point .................................................... 60
Deleting text to the right of the insertion point .................................................. 60
Deleting an attached file from a message ........................................................ 60

CONTACTS ................................................................................................................ 62
What are contacts? .............................................................................................. 62
Opening the Contacts folder ............................................................................. 62
Creating a contact .............................................................................................. 63
Adding the sender of a message to contacts ...................................................... 64
Addressing an email to a contact ...................................................................... 65
Deleting a contact .............................................................................................. 67
What is a contact group? .................................................................................... 67
Creating a new contact group .......................................................................... 67
Adding an email address to a contact group ..................................................... 69
Removing an email address from a contact group ......................................... 70
Sending an email to a contact group ............................................................... 71

ORGANISING MAIL .................................................................................................. 72
Searching for a message ................................................................. 72
Searching for messages by sender, subject or content .................. 72
Creating a new mail folder ............................................................... 73
Moving a message to a different folder ......................................... 74
Deleting a mail folder ................................................................. 75
Sorting the contents of the Inbox .................................................. 75
Deleting a message ................................................................. 76
Opening the 'Deleted Items' folder ................................................ 76
Restoring a message from the ‘Deleted Items’ folder ................. 77
Emptying the ‘Deleted Items’ folder ........................................... 77
Automatically emptying the ‘Deleted Items’ folder when you exit Outlook ........................................... 77
Flagging a message ................................................................. 79
Removing a flag mark from a mail message ................................. 79
Marking a message as unread ...................................................... 80
Marking a message as read ...................................................... 80

CUSTOMISING SETTINGS ................................................................. 81

Displaying or hiding the ribbon .................................................. 81
Adding an Inbox heading ...................................................... 81
Removing an Inbox heading .................................................. 84
Resetting the Inbox headings .................................................. 84
Tutor Setup Information

- Prior to running this course, please make sure that the Outlook Inbox on each computer to be used in the class is empty.

- Issue each person using a computer in the class with their own email address to be used within the classroom.

- Issue each person taking the course with a short list of all the other email addresses that are used by all the other computers within the classroom.

- At the end of the course, remove all files modified or created during the course, prior to re-running the course.

- At the end of the course, reset all program and operating system defaults that may have been modified during the course, prior to re-running the course.
Initial configuration

- When you start Outlook for the first time you may see the following screen.

- Click on the **Next** button to continue and you will see the following screen.

- As Outlook can connect to many different types of E-mail system, you will need to ask your tutor for instructions for proceeding beyond this point.
A first look at Outlook 2010

Starting Outlook 2010

- Click on the Start button and then click on All Programs.

- Click on Microsoft Office folder.

- Click on Microsoft Outlook 2010.
You will then see the Outlook program window displayed.

The Microsoft Outlook 2010 Screen

The Outlook screen has a number of buttons displayed towards the bottom-left of the window. Clicking on these will display screens relevant to Mail, Calendar, Contacts or Tasks.
- **Mail**

- **Calendar**
• Contacts

• Tasks
• In this course we will be concentrating on the use of Outlook to send and receive messages.

Help in Outlook 2010

• When using Outlook you can always press the F1 key for help. The F1 key is a function key displayed towards the top-left of your keyboard. This will display the Outlook Help window, as illustrated.

• Click on the Getting started with Outlook 2010 link and you will see the following.
Click on the **What's new in Outlook 2010** item and you will see the following.
• You can use the vertical scroll bars to display more information further down this window.

• Click on the Back button a few times (top-left of your window).

• Your screen should look like this again.
Click on the **Show Table of Contents** icon (displayed within the Help toolbar).

You will see a table of contents displayed down the left side of the Help window.
• Within the table of contents click (left part of the window) on **E-Mail messages** (you may need to scroll down the table of contents to find this item). You will see this item expands to display subjects relating to E-mail.
• Click on an item, such as **Create an e-mail message**. You will see the following.

![Image of Create an e-mail message](image1)

• Click on the **Customize your e-mail message**. You will see detailed instructions about how to customise a message.

![Image of Customize your e-mail message](image2)
• Have a quick read. Don’t worry about the details. The point to remember is that if you need help, press F1, and from the table of contents get exactly the answers you need.

**Searching for Help**

• You can search for help information using the search facility within the Help window. For instance to search for help about *Keyboard Shortcuts* within Outlook 2010, type in the following.

![Search for Help](image)

• Press the **Enter** key and you will see the following displayed.

![Search results](image)

• Click on the item shown below.

![Keyboard shortcuts](image)

• You will then see a window, similar to that shown below.
• Click on an item, such as **Basic navigation**. You will then see keyboard shortcuts, relating to basic navigation within Outlook displayed, as illustrated below.
Printing help sheets

- Once you have found the help you need within the Outlook help, you can click on the **Print** icon within the Help window toolbar. This will print out the help for you and you can keep it in a folder for future reference. Try this now.

Microsoft Outlook Navigation Pane

- The navigation pane is normally displayed down the far left of the Outlook window.

The navigation pane is used to access the various folders and tabs that together make up the Outlook program.
Microsoft Outlook Ribbon

- The Outlook ribbon is displayed at the top of the Outlook window.

- The ribbon has several tabs displayed across the top: File, Home, Send/Receive, Folder & View in the above example. Other tabs may be available when you are performing certain tasks.

- Each tab is divided into many groups of related buttons.

- The icons/buttons displayed in each group can be clicked upon to perform certain functions.

Closing Outlook

- Close Outlook by clicking on the Close icon in the top-right of the Microsoft Outlook window.
Terminology & Concepts

What is email?

- The word email (also spelt as e-mail) stands for ‘electronic mail’ and describes the sending of messages over networks. These messages can be just plain text or may contain file attachments such as picture files. Once an email is sent they are stored in electronic mailboxes until the person that you sent the e-mail to, requests to look at new email sent to them.

The structure of an email address

- Take a typical email address:

  dave-cheltenham@gmail.com

  The first part of the address “dave-cheltenham”, is the user name and indicates the person to whom the email is addressed.

  The “@” symbol marks the end of the user name.

  The “@” symbol is followed by one or more sub-domains, separated by periods. In the example above the “gmail” is the sub-domain. Sub-domains are registered by organizations or individuals to give themselves an internet identity.

  At the very end of the email address is the TLD or Top Level Domain. In the example the TLD is “.com”, indicating an international company. There are other TLDs such as “.net”, “.org”, “.biz” and “.info” designed to help you identify different types of organization.

The advantages of using email

- **Fast**: One of the great things about email is that you can send messages and files to anyone in the world, almost instantly.

  **Mass communication**: You can write one email and tell the computer to send it to lots of different addresses. This is unlike a physically posted item. Spammers can send out ‘junk email’ to millions of people in one go and this accounts for the ‘spam’ email that most people get once they start using email. This feature however can also be used legitimately, to mail all the employees within a company or to send out a newsletter to maybe thousands of people who have requested that they receive the newsletter.

  **Low cost**: The cost of sending information by email is a fraction of that involved when using the traditional mail system, especially when emailing to a different country.
Worldwide portability: Once you have an email account set up, you should be able to access your email from anywhere that has an Internet connection. Even many holiday hotels now have an email connection for customers!

Time Zone friendly: If you live in Europe and phone someone in the western United States at 9 am locally, you would either get no answer (because the office in the US would be empty), or you could be waking them up in the middle of the night. The great thing about sending an email is that you can send it anytime you want and the recipient will read the mail when they want.

Web-based Email: Many email providers now offer a web-based interface for accessing your email. This enables you to access your message from any web enabled PC or device without the need to install software.

Recommendations for email content and use

- There are some simple rules when sending emails:

**USE SHORT, ACCURATE SUBJECT DESCRIPTIONS:** In a busy office situation, a person may receive many emails a day. Prior to opening the email the only indication that an email might be relevant to that person is the email subject header. Keep emails simple, short and to the point!

Avoid using all upper case letters in a message: The use of letters in UPPER CASE is considered as shouting within an email. Use of all upper case (or all lower case) can also make the message difficult to read.

**BE BRIEF:** People tend to 'skim read' email messages. If they are too long the chances are that the recipient will miss important information buried within the message.

**USE THE SPELL CHECKER:** Never send an email without spell checking the contents first. This can give a really poor impression about your organization.

**RESPECT PRIVACY AND CONFIDENTIALITY:** Never quote part of one person’s email within another email without permission. In many cases there is a message attached to the bottom of emails, warning that the email is confidential!

**DON'T ‘FLAME’:** If some idiot emails you over something which is inappropriate, do not respond and get into a series of increasingly hostile email exchanges. This is called flaming. Never reply to unsolicited email (spam), unless you want to receive even more rubbish in your email inbox!

SMS (Short Message Service)

- Commonly known as 'texting'. SMS allows you to send and receive text messages between mobile (cell) phones.
Voice over Internet Protocol (VoIP)

- Voice over Internet Protocol, (VoIP pronounced voyp), is a technology that allows you to talk with other people via the Internet. You can talk for free to other people using VoIP on their computers. You can even make calls to real telephones at a much cheaper rate than normal. This system is ideal when you need to make a lot of long distance or international calls. You can use VoIP by just installing a microphone and headset, or you can purchase a special VoIP compatible phone, which will normally plug into one of the USB sockets on your computer. A well-known VoIP product supplier is Skype, who produce a range of excellent phones.

- Allows you to make inexpensive long-distance and international calls compared to traditional phone systems.
- You can search for contacts, worldwide.
- You can combine speech with video when you use a Webcam.
- Portable, people can contact you on the move as long as you have an Internet connection. This is especially useful when travelling internationally, as international calls using mobile (cell) phones are very expensive.

**WARNING:** A VoIP phone is not suitable for making emergency calls. If your computer or internet connection is unavailable you may not be able to use the VoIP phone.

Also the voice quality may be worse compared to using a traditional phone.

Instant messaging

- Instant messaging (IM) provides a mechanism for real-time communication between two or more people sending text messages via their computers. This is different from sending an email which once sent may be read sometime later by the person you sent the email to.

- Some types of instant messaging software lets you speak rather than having to type your messages. You can use your web cam so that you can see the person you are talking to.

- **Benefits of Instant Messaging:**

  **Real-time communication:**
  Unlike leaving an email, IM allows you to communicate in real time and have a two way conversation.

  **Knowing whether contacts are online:**
Unlike when sending an email, you can see if the person you want to send the message to is online or not.

**Low cost:**
Compared to tradition phone calls, IM is very cost effective, especially when combined with the flexibility of use and additional features compared to a traditional phone call.

**Ability to transfer files:**
As well as sending text message you can attach files including pictures, sound, video and other files.

**Online (virtual) communities**
- It is important to understanding the concept of online (virtual) communities. These can take many forms including:
  - Social networking websites
  - Internet forums
  - Chat rooms
  - Online computer games

**Social networking websites**
- These sites allow you to link up with other people, to share news, experience and gossip. Some such as ‘Friends Reunited’ are specifically designed to let you find friends that you have lost contact with.

- **MySpace**
Internet forums (message boards / discussion boards)

- An Internet forum is a web-based application that lets you join in online discussions. You can post your views or comments for all in the forum to see and react to. Try searching the Web for information on message boards and you will find that there is a discussion for you, whatever your interest!

Chat rooms

- The term 'chat room' has had a lot of media attention over the last few years. The term has evolved to include any web-based mechanism to share your news.
with other on the web. The communication is in real time, i.e. you can talk to other individuals, rather than leaving messages. Try searching the Web for more information and examples.

**Online computer games**

- Online games are games that are access and played via the Internet. In many cases you can play against other people. Try searching the web use the phrase ‘online computer games’ and you will find lots of sites you can access.
Security Issues

Spam

- Spam is the bulk sending of unsolicited and often fraudulent email messages, normally trying to sell a commercial product or service. There are companies which will sell lists of email addresses by the million. If you are a regular Internet user, then the chances are that the providers of these lists will pick up your email address (using a variety of sneaky techniques). As more and more companies buy in these lists and use them in their marketing campaigns, you will receive more and more spam emails, offering you an increasingly bizarre range of products and services! In many countries the sending of spam is now against the law!

- Increasingly unscrupulous marketing companies are using popup windows within your Web browser to display unwanted messages. There are now many anti-popup programs available to help block this newer type of spam.

Viruses

- Be very careful about opening files which are attached to email messages as they may contain viruses. You should know that Microsoft Word documents can contain special types of virus, called macro viruses. Even pictures can contain virus like code.

Phishing

- Phishing refers to efforts to trick you into revealing your personal or financial information. This is often done by sending out millions of emails at random claiming to be from your bank or similar organizations and then requesting that you update your details, using a link provided within the email. When you click on this link you are taken to a web site that looks just like the real thing but is in fact a copy of a banks web site. When you type in your details, you have just given the information to criminals who will use that information in identity theft related crime.

- Be careful of emails claiming to be from financial institutions or popular web sites instructing you to click on a link and login. Often the link points to a clone of the legitimate web site which is under the control of criminals. Should you click on the link & log into the fake site you will have inadvertently given your password details away. Never click on a link in an email, to be safe open your web browser and type in the address for the web site, this way you can be sure that you are viewing the legitimate site.

Modern web browsers such as Internet Explorer 7+ or Mozilla Firefox 2+ have anti-phishing features that will display a warning if you visit a web site that has been identified as fraudulent.
Digital signatures

- A digital signature is a code which is attached to an email to uniquely identify the sender. Like a traditional hand written signature the purpose of the digital signature is to guarantee that the sender of the message is who he or she claims to be. Digital signatures employ sophisticated encryption techniques to ensure that they cannot be counterfeited.
Sending Messages

Creating and sending your first email

- Start the Outlook application.
- Click on the Mail button, located near to bottom of the navigation pane.

- Click on the Home tab.
- Click on the New E-mail button in the New group on the ribbon.

You will see the Message window displayed, as illustrated.
First you need to enter the email address of the person you are sending the email to, in the To section of the window. Your tutor should have given you a list of email addresses of the other people taking this course. Enter the email address of one of these people.

Next you need to click within the Subject box and type in a title for your email. Type in any title you want such as Message from <your name>.

We are now ready to type out the body text for your email. Click within the white area of the window and you will see the insertion point indicating that you can type your message. In this case type in any message you want. Keep it short as this is just a test email to see if you can send messages. Use a message such as 'Hello, this is a quick email from <your name> to see if my email system is working'

Click on the Send button.

That was it. You have just sent your first email. As you can see using Outlook is really simple, in fact easier than writing a traditional letter and a lot faster to deliver.

Checking that your email was sent

Click on the Sent Items or Sent Mail folder icon in the navigation pane and you will see that the email has been sent as expected.
Depending upon your email system, you may have more than one Sent Items or Sent Mail folders.

**TIP:** If you do not see an item listed here, wait a short while and see if it appears. If you do not see it, try clicking on the **Outbox** icon and see if the item is waiting to be sent. It should disappear from the **Outbox** and then appear in the **Sent Emails** box. If you are still having problems, seek help from your tutor now.

### Sending emails to more than one person at a time

- It is very easy to send your email to lots of people at the same time. Click on the **New E-mail** button again. Click on the **To** box and type in the first email address from the list your tutor has supplied. Then type in a comma and type in the next email on the list (with no spaces). Carry on typing in the entire list of email addresses, remembering to place a comma before each email address that you type in.
- In the **Subject** field, type in a subject for your email (anything will do).
- In the body text area type in a short message.
- Click on the **Send** button and the same message will be sent to everyone on your list.
Receiving emails

- The rest of the class has now sent you an email. Each email will have a different subject and different message content. If you can’t see any new messages, press the **F9** key to force Outlook to retrieve new emails.

- To see what messages you have received, click on the **Inbox** folder icon. Depending on your email system you may have more than one Inbox folder.

- The emails that you have received will be listed in the message list to the right of the navigation pane.
Sending a copy of a message to another address

- To send a copy of a message to another email address, type the address into the Cc (Carbon Copy) field.

  To: seb.cheltenham@gmail.com
  Cc: info@example.com

What is a blind carbon copy?

- A blind carbon copy is a copy of the message which is sent to someone in secret, other recipients of the message will not know that the person has received a copy of the message.

Sending a copy of a message to another address using blind carbon copy

- Whilst composing your email in the Message window, display the Bcc field by clicking on the Options tab selecting the Bcc button from the Show Fields group on the ribbon.

- Type the address of the person you wish to receive the blind carbon copy into the Bcc text box.
• In the example above the message is addressed to sales@cctglobal.com, in addition a copy of the message will also be sent to info@example.com without the knowledge of the other recipients.

**Setting the message subject**

• Enter a short overview of the message into the **Subject** field box.

  Subject: Renew Contract

The message subject should be short but informative. The recipient of the email should be able to get a good idea of the content of the message from just looking at the subject line, this makes managing large volumes of emails much less time consuming.

**Spell checking your message**

• Click on the **Review** tab followed by the **Spelling & Grammar** button, or press the F7 key.

  Outlook will now check the spelling of your message. If an incorrectly spelt word is encountered the **Spelling and Grammar** dialog box will be displayed.
The incorrectly spelt word is displayed in red, Outlook suggests correctly spelt words from its dictionary.

- Select the correct spelling from the list of suggested words and click on the **Change** button to correct the word.
- When Outlook reaches the end of your message the following dialog box is displayed.

![Microsoft Outlook dialog box](Image)

- Click on the **OK** button to close the dialog box and finish the spell checking session.

### Attaching a file to a message
- Display the **Message** tab and click on the **Attach File** button from the Include section.
Outlook will display the **Insert File** dialog box, locate and select the file you wish to attach to your message.

![Insert File dialog box](image)

Click on the **Insert** button. The **Insert File** dialog box will close, the attached file will be shown below the **Subject** field.

![Attached file](image)

When you are attaching files to emails be aware of the file size. In general, messages travelling across the internet with files greater than 5 megabytes in size attached are likely to be returned undelivered. Certain files types such as Windows executable (.EXE) files may also be rejected as they are common carriers of viruses or malware.

**Deleting an attached file from an outgoing message**

Attached files are displayed below the **Subject** field. To delete an attached file, right click on the file you wish to delete to display a popup menu.
• Select the **Remove** command. The file is no longer attached to the message.

**Issues when sending file attachments**

• There are a number of issues to consider such as:

  **File size limits:**
  If you attach a file of a certain size, then the coding necessary to attach the file to the email will make the file size of the attached file larger than the original file size.

  Many email systems will set limits on the size of email attachment that they will accept. These limits differ from one system to another. Also remember that the larger the attached file the longer your email will take to be delivered.

  **File type restrictions:**
  Many email systems will block attached files if the attachments is an executable file. This is because many virus and other malicious software types are spread through the emailing of attached executable files. Even if you can attach an executable file, do not be surprised if the email is rejected by the email software of the person you are sending the file to.

  **Do not send to many attachments at the same time:**
  Sending a lot of simultaneous attachments (such as photographs), may exceed file size attachment limits.

  **Netiquette:**
  Remember do not send large file attachments to people who are not expecting them.

**Setting message importance (message priority)**

• Click on the **Message** tab. Use the icons in the **Tags** group to assign importance to your message.
Setting message sensitivity

- To set the sensitivity of your message, click on the **Message** tab and then click on the Message Options dialog box launcher icon as shown.

- A dialog box will be displayed enabling you to set the **Importance & Sensitivity** options.

- Close the dialog box by clicking on the **Close** button.

Saving a draft copy of an e-mail

- It is possible to save an email that you are currently writing to be completed and sent at a later time.
- To do this, simply click on the **Save** icon, displayed at the top-left of the Message window.

- You may now close the **Message** window by clicking on the **Close** icon.
- The message will be saved into the **Drafts** mail folder. To resume editing the message open the **Drafts** mail folder from the navigation pane and double-click on the message.
Receiving, reading and replying to messages

The Inbox folder
- The Inbox folder is where you view & reply to email messages that you have received.

Opening the Inbox folder
- To open the Inbox folder, click on the word *Inbox* displayed in the navigation pane to the left of the Outlook window.

Depending on your email system you may have more than one Inbox folder. Open the Inbox folder which contains the email messages which you have received.
The Inbox screen

- By default the Inbox screen is displayed as below. The navigation pane is on the far left with any message contained within the Inbox listed beside it. To the right of the message list is the reading pane; the content of the message is displayed here.

Selecting a message

- To select a message, click on the message in the list.
Once a message is selected, the contents of that message will be displayed in the reading pane.

Message Status icons

- Messages have icons associated with them to help you manage your emails.

A closed envelope means that the message has not been read.

An open envelope is displayed next to a message that has been viewed.

You can attach flags to messages that you need to revisit at a later date. We will see how to do this later.

Reading a message

- Sometimes it is more convenient to view a message in a separate window; this allows you to have multiple messages on view simultaneously. To do this double
click on the message, a new message window will open.

The message window displays the message text along with the headers which show who the message was from and the subject.

To close the message window click on the Close icon in the top right of the window.

Switching between open Message windows

- Double click on three messages to open them in their own Message window. Point at the Outlook icon displayed on the Windows Taskbar at the bottom of your screen.
A menu will be displayed listing all of the open Outlook windows.

- To switch between messages click on the relevant entry in the menu.
- Use this method to view the 3 messages you opened. Once finished, close all the message windows.

**Forwarding a message**

- Select one of the messages in your inbox.
- Click on the **Home** tab.
- Click the **Forward** button displayed within the **Respond** group on the ribbon.

- A new **Message** window will open.
You will see the text of the original message is inserted for you. The subject of the original message has also been copied with the text **FW:** inserted at the beginning, this is done so that the recipient of the message can easily see that the message has been forwarded.

- If you wish you can add your own comments by typing them into the top of the message text area.
- Enter the email address, into the **To** address field, of the person that you would like to forward the message to.
- Click on the **Send** icon to send the message.

**Opening or saving an attached file**

- If a message has a file attached, an icon and the file name for each attached file will be displayed just below the message subject.
• Double-click on the file icon; the following dialog box will be displayed. You should always be cautious about opening files sent to you by email.

• To open the file click on the Open button. You also have the option to click on the Save button, this will open the Save As window allowing you to save the file to your drive for later use.

Replying to the sender of a message
• Select a message from your Inbox that you would like to reply to.
• Click on the Home tab.
• Click the Reply button displayed within the Respond group on the ribbon.

• A Message window will open containing the text of the message you are replying to.
Outlook automatically inserts the email address of the sender into the To field. The subject is also copied with the text RE: inserted at the start.

- Type your reply in the message text area, just above the original message.
- Send your message by clicking on the Send icon.

**Replying to the sender and all recipients of a message**

- Open your Inbox folder and select a message that was sent to many recipients.
- Click on the Home tab.
- Click the Reply All button displayed within the Respond group on the ribbon.
A Message window will open containing the text of the message you are replying to.

You will see that Outlook has automatically inserted the email address of the sender, plus any recipients of the original message.

- Type your reply in the message text area, just above the original message.
- Send your message by clicking on the Send icon.
Setting message reply options so that the original message is inserted, or not inserted

- Click on the File tab and select the Options button from the menu on the left.

- The Outlook Options dialog box will be displayed.
• Select the **Mail** button from the list at the left of the **Outlook Options** dialog box. Settings relating to email will be displayed in the main area.

![Outlook Options dialog box](image)

• Scroll down the list of options until the **Replies and forwards** section is visible.

![Replies and forwards options](image)

• To control whether/how the original message is inserted when you reply to a message click on the button to the right of the **When replying to a message** text. Select the reply style that you require, try selecting **Do not include original message**.
Click on the **OK** button to close the **Outlook Options** dialog box.

Try replying to a message from your Inbox, you should now find that the original message is not now inserted into the message text area.

Re-open the **Outlook Options** dialog box and reset the reply style back to **Include original message text**.

### Printing a message

- To print a message, first select the message by clicking on its entry in the message list.
- Click on the **File** tab and select **Print** from the menu on the left.
• Click on the **Print** icon.

![Print Icon](image)

• The message is now printed.

**Previewing a message before printing**

• Select the message you wish to print preview.
• Click on the **File** tab and select **Print** from the menu on the left.

![File Tab with Print Option](image)

• A preview of how the message will be printed is shown to the right of the printing options.

![Message Preview](image)
Printing Options

- More sophisticated printing settings can be accessed by clicking on the **File** tab and selecting **Print** from the menu on the left.

- Now click on the **Print Options** button.

- The options in this dialog box allow you to choose how many copies of the message are printed and the style of printing.
Clicking on the **Print** button will close the **Print** dialog box and print the message using your chosen options.
Manipulating Text and Files

Selecting a word within the Message window

- Open a new message window & enter 3 paragraphs of text.
- Select a word by double clicking on the word of your choice. Once selected the word will be highlighted.

Selecting a line within the Message window

- Move your mouse pointer into the left margin next to the line you want to select. The mouse pointer will flip over to point to the right.
• Click the mouse button, the line will be selected and highlighted.

- This is some sample text for my email. Sending emails is a very efficient method of communication.

- The selected paragraph will be highlighted.

Selecting all text within the Message window

• Press the Ctrl-A key combination. All of the text in the message text area will now be selected and highlighted.

- Click once on the message text to clear the selection.

Selecting text using the mouse

• Locate the start of the text you want to select with your mouse pointer.
• Press the left mouse button and whilst keeping the mouse button pressed down, move the mouse pointer to the last piece of text you wish to select.
• Release the mouse button, the text will remain selected and highlighted.

:ext for my email. Sending emails is a very efficient method of communica
mail. Sending emails is a very efficient method of communication]. This is
emails is a very efficient method of communication. This is some sample

Copying text to the Clipboard from a message

• Select the text you wish to copy.
• Press the Ctrl-C key combination, or click the Copy icon in the Clipboard group on the ribbon.

Pasting text from the Clipboard into a message

• Click your mouse at the end of the message to move the text insertion point.
• Press the Ctrl-V key combination, or click the Paste icon in the Clipboard group on the ribbon.

Copying text from one message to another

• Open a second new message window.
• Re-display the first message containing your text.
• Select some text of your choice and copy it to the clipboard.
• Select the new message window and click within the message text area.
• Paste text from the clipboard into the message text area.
• Close the new message window and re-display the first message containing your text.
Cutting text to the Clipboard from a message

- Select the text you wish to cut/move to the clipboard.
- Press the Ctrl-X key combination, or click the Cut icon in the Clipboard group on the ribbon.

Moving text from one message to another

- Select the text you wish to cut/move to the clipboard and press the Ctrl-X key combination.
- Open a new message window and click within the empty message text area.
- Paste text from the clipboard into the message text area (by pressing Ctrl-V).
- Close the new message window and re-display the first message containing your text.

Copying text from another application into a message

- Open the Windows Notepad application.
- Enter some text into the Notepad window.
- Press Ctrl-A to select the text in the Notepad window.
- Press Ctrl-C to copy the text to the clipboard.
- Re-display the Outlook message window containing your sample text.
- Click your mouse at the end of the message to move the text insertion point.
• Press the Ctrl-V key to paste the text into your message.

  Sample text for my email. Sending emails is a very efficient method for my email. Sending emails is a very efficient method.

  This is some text that I would like to copy into my message.

• Close the Notepad window by clicking on the close icon in the top-right of the window.

Deleting text in a message

• Select the text you wish to delete.
• Press the Delete key.

Deleting text to the left of the insertion point

• Click at the end of a word to move the insertion point to that location.
• To delete the letter immediately to the left of the insertion point press the Backspace key.

Deleting text to the right of the insertion point

• Click at the start of a word to move the insertion point to that location.
• To delete the letter immediately to the right of the insertion point press the Delete key.
• Close the message window without sending the message.

Deleting an attached file from a message

• Locate a message that has a file attached. Messages with files attached have the paperclip icon displayed next to them.

  ![Yesterday]
  ![New Course]
  ![David Murray]

• Double click on the message to open it in a message window. The attached files are listed beneath the subject line.
• Right-click on the attached file you wish to delete and select the Remove Attachment command from the menu.
• The file is deleted from the message.
• Close the message window by clicking on the Close icon in the top-right of the window. You will see the following dialog box.

![Microsoft Outlook dialog box](image)

The attachments of the message "New Course" have been changed.
Do you want to save changes to this message?

- Yes
- No
- Cancel

• Click on the Yes button to save the modified message.
Contacts

What are contacts?
- The Outlook Contacts folder is an area where you can store information about people you have regular communication with. The Contacts folder is your address book.

Opening the Contacts folder
- Click on the Contacts button at the bottom of the navigation pane.

- The Contacts folder will be displayed as illustrated.
Note: At this stage you may not see any contact cards displayed in the main screen area.

Creating a contact

- Create a contact by clicking on the New Contact button, located in the New group on the Home tab of the ribbon.

- The Contact window will open as illustrated.

- Fill in the fields using the details of one of your fellow students. In particular make sure that you enter their email address into the E-mail box.
Click the **Save & Close** icon on the ribbon to close the **Contact** window and create your contact.

You should now see a contact card displayed for your new contact.

Repeat these steps to add at least 2 more contacts.

**Adding the sender of a message to contacts**

Open the Inbox folder and select a message.

Right click on the senders email address (normally displayed just below the subject line) and select the **Add to Outlook Contacts** command.
• The **Contacts** window will open. Outlook will pre-fill as many fields as possible using information from the email.

• Fill in the remaining fields and click on the **Save & Close** icon on the ribbon.

**Addressing an email to a contact**

• Open the **Inbox** folder.
• Select the **Home** tab.
• Click on the **New E-mail** button displayed on the ribbon to open a new Message window.
• Click on the **To** button.
The **Select Names: Contacts** dialog box will be displayed as illustrated.

Notice that your contacts are listed in the dialog box.

- Select one of your contacts from the list by clicking on their name. The selected contact will be highlighted.
- Click on the **To ->** button. The name of the contact will be inserted into the box beside the button. This has told Outlook that you wish to address the email to this person.

You could also have clicked on the **Cc** or **Bcc** buttons to send them a carbon copy of the email.

- Click on the **OK** button to close the **Select Names: Contacts** dialog box. Outlook will copy the contacts email address into the Message window.
• Enter a subject and some text into the message text area.
• Send the message.

Deleting a contact
• Open the Contacts folder.
• Click on a contact you wish to delete. The contact will be selected and highlighted.
• Press the Delete key. The contact will be moved to the Deleted Items folder.

What is a contact group?
• A contact group is a collection of contacts. A contact group allows you to maintain a list of contacts so that you can make contact with them as a group. For example you may have a distribution list called “customers” allowing you to email details of new products and offers to prospective customers.

Creating a new contact group
• Open the Contacts folder.
• Select the Home tab.
• Click on the New Contact Group button contained within the New group on the ribbon.
• The Contact Group window will be displayed.
- Give your contact group a name by typing it into the Name box. Use the name Students.

- Click the Save & Close icon on the ribbon.

- A new contact card will be created for your contact group.
Adding an email address to a contact group

- Open the Students contact group by double clicking on the Students contact card. The Contact Group window will be displayed.
- Click on the Add Members button, displayed in the Members group on the ribbon.
- From the displayed menu select the New E-mail Contact option.
- The Add New Member dialog box will be displayed.
- Enter the name of one of your fellow students into the Display name box. Enter their email address into the E-mail address box.
• Click on the OK button to add this email address to the contact group. You will find that the person you added to the list is now displayed in the Contact Group window.

• Repeat these steps to add the other email addresses on the list provided by your tutor.

• Save and close the Students contact group.

Removing an email address from a contact group

• Open the Students contact group and select an email address you want to delete from the group. To select an email address click on the name or email address, the selected entry will be highlighted.

• Click the Remove Member button, displayed on the ribbon.
The email address will be removed from the contact group.
Save and close the Students contact group.

Sending an email to a contact group

- Open the Inbox folder.
- Select the Home tab.
- Click on the New E-mail button displayed on the ribbon to open a new Message window.
- Type the name of your contact group into the To box, in this case type Students. After a few seconds Outlook will recognise that you have entered the name of a contact group, a box containing a plus symbol will be displayed next to the contact group name.
- Enter a subject and some text into the message text area.
- Send the message as normal.
Organising Mail

Searching for a message

- Display the Inbox folder. Located above the list of messages is the Search box, as illustrated.

- Type a word into the search box. Outlook will search the Inbox and list any messages that contain that word.

Searching for messages by sender, subject or content

- Click within the Search box, located above the message list.
• The **Search** tab will be displayed on the ribbon.

![Outlook Search Tab](image)

• The buttons on the **Refine** group allow you to specify which areas of the messages are searched. For example, if you wanted to search the message subject only you would click on the **Subject** button and then enter your search word. Experiment with these features.

### Creating a new mail folder

• Open the Inbox folder.
• Click on the **Folder** tab.

![Outlook Folder Tab](image)

• Click on the **New Folder** button in the **New** group on the ribbon.

![Outlook New Folder Button](image)

• The **Create New Folder** dialog box will be displayed.
• Type the word **Projects** into the **Name** box.

• Click on the **OK** button. A sub-folder called Projects will now appear under the Inbox folder in the navigation pane.

**Moving a message to a different folder**

• Open your Inbox folder.
• Locate a message and position the mouse pointer over it.
• Press the left mouse button and whilst keeping the button pressed down move the mouse button to the **Projects** folder in the navigation pane.

Notice that the mouse pointer has a rectangle attached to it, this represents the message you are moving.

• Release the mouse button and the message will be moved to the Projects folder.
Deleting a mail folder

- Right-click on the **Projects** folder in the navigation pane.

- Select the **Delete Folder** command from the menu. The following dialog box is displayed.

- Click on the **Yes** button and the mail folder will be moved to the Deleted Items folder.

Sorting the contents of the Inbox

- By default Outlook lists the contents of the Inbox folder in date order. You can change this behaviour by clicking on the **Arrange By** text located under the Search box.
Try selecting some of the other arrangement options such as Subject, From, To and Size and observe the effect on the Inbox.

- Restore the Inbox back to date order.

**Deleting a message**

- To delete a message, first select the message by clicking on its entry in the Inbox message list.
- Click on the Delete button, displayed on the ribbon within the Delete group in the Home tab.

- The message is moved to the Deleted Items folder.

**Opening the ‘Deleted Items’ folder**

- Locate the Deleted Items folder listed in the Outlook navigation pane.
Depending on your email system, you may have more than one Deleted Items folder.

- Click on the Deleted Items text to open the Deleted Items folder.

**Restoring a message from the ‘Deleted Items’ folder**

- The contents of the Deleted Items folder are displayed to the right of the navigation pane.
- Locate the message you deleted earlier and position the mouse pointer over it.
- Press the left mouse button and whilst keeping the button pressed down move the mouse pointer to the Inbox folder in the navigation pane.

Notice that the mouse pointer has a rectangle attached to it, this represents the message you are moving.

- Release the mouse button and the message will be deposited in the Inbox folder.

**Emptying the ‘Deleted Items’ folder**

- Open the Deleted Items folder.
- Select the Folder tab.
- Click on the Empty Folder button contained within the Clean Up section of the ribbon.

**Automatically emptying the ‘Deleted Items’ folder when you exit Outlook**

- Click on the File tab and select the Options button from the menu on the left.
• The **Outlook Options** dialog box will be displayed.

• Select the **Advanced** button from the list at the left of the **Outlook Options** dialog box.
• Tick the check box labelled **Empty the Deleted Items folders when exiting Outlook**.
• Click on the **OK** button to close the **Outlook Options** dialog box.

### Flagging a message

- To flag a message click on the **Flag** icon displayed next to the message in the **Inbox** folder.

### Removing a flag mark from a mail message

- To remove a flag from a message, right-click on the **Flag** icon and select the **Clear Flag** command from the menu.
Marking a message as unread

- To mark a message that you have read as unread, right-click on the message on the Inbox folder and select **Mark as Unread** command from the menu.

Marking a message as read

- To mark a message that you have not read as read, right-click on the message on the Inbox folder and select **Mark as Read** command from the menu.
Customising Settings

Displaying or hiding the ribbon

- Click on the Minimize the Ribbon button, displayed at the top-right of the Outlook window.

  ![Minimize the Ribbon button]

- The ribbon is now hidden from view.

- Repeating the above restores the ribbon.

Adding an Inbox heading

- You can customize the information shown about each email listed in the Inbox folder.
- Click on the View tab.
- Click on the View Settings button, displayed in the Current View group on the ribbon.

  ![View Settings button]

- The Advanced View Settings dialog box is displayed.
• Click on the **Columns** button. The **Show Columns** dialog box will be displayed.

This dialog box allows you to control the information displayed about each message in the Inbox folder list. The **Available columns** list on the left of the dialog box shows the fields that can be added, whilst the **Show these columns in this order** listing on the right shows the information that is to be displayed.

• Select **Message** from the **Available columns** listing.
• Click on the Add button to move the Message column across to the **Show these fields in this order** list.

• Click on the **Move Up** button repeatedly until the Message field is displayed at the top of the **Show these columns in this order** list.

• Click on the **OK** button to close the **Show Columns** dialog box.
• Click on the **OK** button to close the **Advanced View Settings** dialog box.
• The message listing will now change. You should now see that the first few lines of the email are displayed instead of the subject line.

**Before:**
After:

- Re-open the Show Columns dialog box.
- Select Message from the Show these columns in this order list.

![Show Columns Dialog Box]

- Click on the Remove button. The Message column should now be moved from the Show these columns in this order list to the Available columns listing.
- Click on the OK button to close the Show Fields dialog box.
- Click on the OK button to close the Advanced View Settings dialog box.
- The message listing will now change with the message subject displayed once more.

Resetting the Inbox headings

- Click on the View tab.
- Click on the Reset View button, displayed in the Current View group on the ribbon.
• The following dialog box will be displayed.

![Microsoft Outlook dialog box](image)

- Are you sure you want to reset the view "Hide Messages Marked for Deletion" to its original settings?

  - [Yes]
  - [No]

• Click on the Yes button to reset the view.